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1 About This Document

This document describes the reference design for Flexibilis Redundant Switch (FRS) [7]. FRS
is an Ethernet switch Intellectual Property (IP) core targeted at programmable hardware
platforms. The FRS is a variation of Flexibilis Ethernet Switch (FES).

The purpose of the Reference Design is to provide an FRS evaluation platform and it may be
used as is or modified as required. The Reference Design implements a HSR/PRP RedBox
with support for 1588 PTP ordinary and transparent clocks. The Reference Design is provided
for Cyclone IV GX, Cyclone V GX and Cyclone V GT evaluation boards and it is
downloadable from Flexibilis website www.flexibilis.com. There is also a Reference Design for
Cyclone V SoC evaluation board but it is not covered by this document.

Chapter 2 describes the Reference Design in general. Chapter 3 describes the FPGA part of
the Reference Design, i.e. VHDL, IP and QSYS issues. Chapter 4 describes the software
included in the Reference Design. Chapter 5 contains abbreviations and chapter 6
references.

1.1 Conventions Used in This Document

Register descriptions in this document follow these rules: Unless otherwise stated, all the bits
that activate or enable something are active when their value is 1 and inactive when their
value is 0. The explanation of the bit types is the following:

RO = Read Capable Only. The bits marked with RO can be read. Writing to these bits is
allowed if not otherwise stated. If writing is allowed, it does not affect the value of the bit.

R/W = Read and Write capable. The bits can be read and written. Writing 1 to the bit makes
its value 1. Writing O to the bit makes its value 0.

R/C = Read and Clear capable. The bits can be read and cleared. Writing 0 to the bit makes
its value 0. Writing 1 does nothing.

R/SC = Read and Self Clear. The bits can be read. After reading bits, the value automatically
returns back to O.

R/W/SC = Read, Write and Self Clear. The bits can be read and written. Writing 0 to the bit
does nothing. Writing 1 to the bit makes its value 1 for a while, but after that the value
automatically returns back to O.

The bits marked as Reserved should not be written anything but 0, even if they are marked as
read capable only, because their function may change in future versions.

Bit and byte order used for 16, 32 and 64 registers is depicted in Figure 1. Leftmost byte is in
the lowest address.

Bit 15 8 7 0
16bit Bus
or Byte 1 Byte 0
Register:
MSB LSB
Bit 31 24 23 16 15 8 7 0
32bit Bus
or Byte 3 Byte 2 Byte 1 Byte 0
Register:
MSB LSB
Bit 63 56 55 48 47 40 39 32 31 24 23 16 15 8 7 0
64bit Bus
or Byte 7 Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 Byte 0
Register:
MSB LSB

Figure 1. Bit and Byte Order

Specification 6 (34) Version 1.7
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Signal names are written in document with signalName style. Block names are written with
Capital first letter. Pseudo code is written with PseudoCode style and command line
commands are written with CommandLine style.
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2 General

The FRS Reference Design consists of FPGA and SW design. The SW is run on NIOS2
softcore processor. The FPGA design is implemented using Altera QSYS tool that provides a
graphical description for FPGA systems. FPGA design compilations are made using Altera
Quartus Il tool and the SW is compiled using Altera NIOS Il EDS. Version information about
the tools used, the IP blocks and the SW components are listed in the Reference Design
release notes included in the release package.
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3 FPGA Reference Design

The FPGA HW part of the design is described in this chapter.

3.1 Top Level

The Reference Design block diagram with external interfaces is described below. There are
some differences between the Cyclone IV GX (C4GX), Cyclone V GX (C5GX) and Cyclone V
GT (C5GT) designs, but mainly the designs are the same.

The main differences are:

1.

2.

C5GT reference design has fourth SFP module (SGMII/1000Base-X) instead of
RGMII interface

CAGX reference design uses external 125 MHz clock source for transceiver reference
clock. The C5GX/C5GT have fractional PLL to generate it from one common clock
input of 50 MHz.

Evaluation Board

User LEDs (Onboard)
0 User DIP Switches (Onboard)
i User Push-Buttons (Onboard)
3xI12C

FPGA

PPS Output (SMA)

RGMIT
Clocks and reset ] e Bt
PHY XR7_softsoc (QSYS) OCKSIaNCiIese! Reset Push-Button
STA MDIO (this is FPGA top level)
[Xeh) ‘ LD ‘

Flash ) ‘ Flash ‘

Pin header ‘ q MMD MDIO
Authentication ) ‘ Pin header

Figure 2. Reference Design Block Diagram

The Reference Design provides the following interfaces

3 x SGMII interface for fiber and copper SFP modules. (1000BASE-X and SGMII)
o Redundant Port A
o Redundant Port B
o Interlink
o In CVGT there is fourth SFP interlink
RGMII interface for onboard PHY (only C4GX, CVGX)
MMD MDIO/MDC for FRS management. Routed to external pin header (if available)
STA MDIO(MDC for PHY management)
12C interfaces for SFP module management
LCD interface
o C4GX and C5GX have identical LCD command interfaces. For C5GT the
interface is 12C.
Authentication, routed to external pin header (if available)
o Not available in C5GX. The design will function for 2 hours.
o Note that the Authentication chip [11] is not on the evaluation board (C4GX,
C5GT). Without external security chip the design will function for 2 hours
Flash for FPGA configuration
Push-buttons and DIP switches
User and Link LEDs
Clocks and reset
o C4GX
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= 50 MHz, clk
e Main clock for QSYS components
e QSYS design (xr7_softsoc) contains PLL’s to generate all
needed clock frequencies except :
= 125MHz, eth_clk
e Used directly as transceiver reference clock

o C5GX
= 50 MHz, clk
e Main clock for QSYS components
e QSYS design (xr7_softsoc) contains PLL’s to generate all
needed clock frequencies including transceiver reference
clock
o Cb5GT
= 50 MHz, clk

e Main clock for QSYS components

e QSYS design (xr7_softsoc) contains PLL’s to generate all
needed clock frequencies including transceiver reference
clock

3.2 QSYS Design

The QSYS design, xr7_softsoc, is a combination of many QSYS components and their sub
components. The block diagram below describes the QSYS system in the highest level and
clock, reset and Avalon routing.

Sys ID

— PIOPB [-¢—— Push-Buttons———
—K
PIO Reference Design
Version
— PIO DIPSW l———DIP Switch————
A
- LCD > LCD z
M £ PIO LED L b
(e} S, N—
z [—
- MDIO > ETHMDIO ]
- MDG- - With 3-state wrapper " PIO Control CTRL
~-4————MMD MDIO———| MDIO to Avalon

Timer

NOIVAY

4————SGMI|—————

Link LED FES System
Tri-State Bridge [ Flash———»
< SGMI -

- Link LED-

Flash Controller

A4——SGMIl———— N
- Link LED L
125 MHz serdes refclk
(only CIVGX) — G -~
1 PIO (12C) - 20 >
‘ RGMII and Link LED, » I 12C -
(not in C5GT) A [———2C—»

<—Authemicatio"->@

JTAG (UAR
CLK | ¢ g
h A —
= - clk_50
50 MHz and reset = RESET | ||
CLK
Avalon clk_125 RESET Onchip Memory
reset
control and CLK P
PLL's k25 |ReseT
ok lcd NIOS
(notin (NIOS_JTAG_DEBUG)
C5GT)

Figure 3. XR7_softsoc Design Block Diagram
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XR7_softsoc includes the following components:

1. Avalon reset control and PLL’s
a. CPU_RESET push button de-bouncing function
b. PLL’s to generate needed clocks
c. Clock bridge and clock source components are used in QSYS designs to
import and distribute clock and resets into the QSYS system/components
2. FES System
a. More detailed description in the next chapter
3. Authentication multiplexer
a. Used to multiplex up to four FRS to use single SeclP. Used here even though
there’s only one FRS.
4. MDIO Slave
a. Provide method for the MMD MDIO to access Avalon.

5. ETH MDIO
a. Provides MDIO/MDC interface for NIOS. Used to configure external RGMI|
PHY.

b. Use with 3-state wrapper makes it possible to export 3-state signals (without
separate top level design file)
6. LCD
a. Provides LCD interface
b. In C5GT the block is 12C
7. Reference Design Version
a. Includes Reference Design version nhumber
8. SYSID
a. Includes System ID
9. NIOS Il Soft processor core
a. Includes also JTAG debug module
10. Onchip memory
a. Onchip memory is used for SW and for AFEC TX and RX buffers
11. JTAG Uart
a. Enables NIOS SW debugging
12. 12C
a. Actually a Parallel 10 block (PIO), used to generate 12C interface
13. Flash Controller
a. Configuration Flash controller
14. Timer
15. PIO Control
a. Control signals, currently only PHY Reset
16. PIO LED
a. Control LEDs
17. PIO DIPSW
a. User DIP switch signals
18. PIO PB
a. User Push-Buttons

3.2.1 FES System

The FES System QSYS component is actually a subsystem i.e. it includes other QSYS
components. It is generated based on configurations with tcl scripts, which can be found in
the FES System component folder. The FES System component block diagram with current
configuration is presented in Figure 4.

In previous Reference design versions, up to 2.9.4, similar block was called FRS Redbox.
However, as the Flexibilis Ethernet Switch (FES) and Flexibilis Redundant Switch (FRS) were
combined into same IP block, the FRS Redbox component was also replaced with a new
QSYS component.
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FES System ‘

5 p -t uthentication————»
econfig
A 4

A

—TX/RX Buffers (Avalon)——= AFEC MI—p| Port0

A4
A\

[ SGMIN1000Basex "B qyiio008asex | M
Link LED———]— Portl
—Serdes CLK and reset: or Triple_mode - >

———SGMII/1000Base-x——"—= Avalon
| | seMIi1000BaseX g GMIl—»=| P> Arbiter | Avalon A

Link LED—— Port2
L - 4
| Serdes CLK and reset RN |y > ) Avalon B—— >
(4-Time® FRTC |<t—|

I SGMIIIL000Base x——1P1  ¢y100asex |4l i
Link LED————n— Port3

| Serdes CLK and reset——w{ O TfPle_mede <& -

REYSRYRY

2 Avalon

RGMI——=
CLK and reset—————# RGMII -t
Link LED———

Mk pons
>

LA

25 MHz and reset————| MII CLK

AVALON

—T—50 MHz and reset————»| Avalon CLK

——125 MHz and reset———®= System CLK

——Reconfig clk and reset—m  Reconfig CLK

Figure 4. FES System Component Block Diagram
FES (FRS)

FES QSYS component is the Ethernet switch core which instantiated Flexibilis Ethernet
Switch [7]. It can be instantiated also in QSYS as a separate component “Flexibilis Ethernet
Switch” (FES_core) or in the VHDL code.

Flexibilis Ethernet Switch supports optional features which enable redundant communication
(FRS variation). For more information see FES user manual [7].

AFEC

Advanced Flexibilis Ethernet Controller (AFEC) acts as an Ethernet Controller for the NIOS.
More info on AFEC can be found in the AFEC user Manual [6].

SGMII/1000BASE-X

SGMII/1000BASE-X adapters, used in Cyclone IV reference design, provide interface
conversion between GMII (FRS) and SGMII/1000BASE-X. This component includes Altera
Transceiver IP, which is for Cyclone IV “ALTGXB” and for Cyclone V “Custom PHY”.

TRIPLE MODE

Triple Mode adapter, used in Cyclone V reference design, provides interface conversion
between GMII (FRS) and SGMII/1000BASE-X/100BASE-FX.

RGMII
RGMII adapter provides interface conversion between GMII (FRS) and RGMII.

RECONFIG
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Since the design implements Transceivers in the SGMII/1000BASE-X adapter, this block is
required to be instantiated. Currently it does not include any functionality.

FRTC

Flexibilis Real Time Clock provides time information for FRS. FRTC can be controlled via
Avalon.

IRQ BRIDGE
IRQ Bridge component provides a QSYS supported method for interrupt mapping.

CLOCK SOURCES

FES System component includes four clock source components (mii_clk, avalon_clk,
system_clk, reconfig_clk ), that are used to map clock signals into QSYS components.

AVALON ARBITER

The Avalon Arbiter is able to provide arbitration functionalities for two different Avalon
masters. In this case the masters are

- MDIO Slave
- NIOS

AVALON SPLITTER

The Avalon Splitter component is generated automatically by the QSYS to support older FRS
control mechanisms, even though it would not be required in this case.

3.3 FES System Configuration

This chapter describes how FES system component is configured and how configurations
affect the actual design.

To ease the configuration, instantiation and mapping of VHDL designs, the QSYS component
provides automatic component and signal mapping and instantiation based on the
configuration made in QSYS GUI.

Specification 13 (34) Version 1.7
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3.3.1 Generic Configuration
System: xr7_softsoc  Path: fes_systemn_0

FLE\/lbl W L= res system

fes_system

|* Customization

DEVICE_FAMILY: [y clone v

Generics  Interface options  Interface configuration

RST_ACTIVE: ]
FES_PORT_HIGH: 4
PORT_STATE_DEFALLT: |355
GIGABLT: i
COUNTERS: )
QUELES: 4
MACSEC: 0

MACSEC_CIPHER.:

=

HSR_PORTS: 14
PRP_PORTS: 14
CT_PORTS: 5
SMAC_TABLE_ROWS: g
POLICING: 0
POLICERS: 7
SHAPERS: 0
CFG_CLK_FREQ: 125

Figure 5. Generics

FES System Generics configurations page is shown in Figure 1, with settings used in this
case. The configurable generics are:

- FES_PORT_HIGH
o Sets the port count. Value 4 means that there are five ports.
-  PORT_STATE_DEFAULT
o Sets the default value for all PORT_STATE registers. Value 288 is 0x0120,
which sets ports to forwarding mode, GMII and 1000Mbps
GIGABIT
o Enables Gigabit operation (optional feature of FES). For more information
see FES user manual [7]
o Gigabit operation is enabled in the reference design
COUNTERS
o If COUNTERS = ‘1’ then the COUNTERS block is synthesized (optional
feature of FES). Use value ‘0’ when no COUNTERS are needed to save
logic.
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o Counters are enabled in the reference design.
- QEUEUS
o Number of priority queues (optional feature of FES). Possible values are 4
and 8. For more information see FES user manual [7].
o Reference design uses 4 priority queues
- MACSEC
o MACSEC port mask. Enables MACSEC functionality on corresponding port
(optional feature of FES). For more information see FES user manual [7].
o MACSEC is not supported in the reference design
- HSR_PORTS
o Defines which ports support HSR. HSR support is optional features of FES.
o Decimal value 14 means that ports 1,2 and 3 include HSR capabilities
- PRP_PORTS
o Defines which ports support PRP. PRP support is optional features of FES.
o Decimal value 14 means that ports 1,2 and 3 include PRP capabilities
-  CT_PORTS
o Enables Cut-through operation between two HSR ports. Cut-through is an
optional feature of FES. For more information see FES user manual [7].
o Value 6, means ports 1 and 2.
- SMAC_TABLE_ROWS
o Defines how many rows are supported by the SMAC. SMAC is an optional
feature of FES [7].
o Inthis reference design the SMAC is not enabled.
- POLICING
o Enables Policer functionalities (optional feature of FES). For more information
see FES user manual [7].
= Value 0: no policing functionalities (bandwidth limiting) supported
= Value 1: Policing supported via IPO
= Value 2: Policing supported via SMAC
= Value 3: Policing supported via SMAC/IPO, selectable via registers
configurations
o Inthe reference design the policers are not supported
- POLICERS
o Defines how many policers are supported per port. value 7 means 128
policers, value 8 means 256 policers etc.
o Requires that POLICING generic has a value 1,2 or 3.
- SHAPERS
o Enables Shaping functionalities (optional feature of FES). For more
information see FES user manual [7].
o Shaping is not supported by the reference design
- CFG_CLK_FREQ
o This defines the system clock frequency for the FES and it must be set to
match the actual clock frequency. In this case it is 125 MHz
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3.3.2 Interface Options

System: xr7_softsoc  Path: fes_system_0

FLE\/lbl W E= Fes system

fes_system

|* Customization

DEVICE_FAMILY: | cvelone v

Generics Interface options  Interface configuration

AVS_ADDR_MSB: 20
LED_ACTIVE: 0
GXB_CHANNEL_OFFSET: |5

Enable avalon slave A interface

Enable avalon slave B interface

[ ] Enable external speed interfaces

[ ] Enable authentication inter face

[ ] Enable external transceiver reconfiguration interface

Enable traffic LED interface

Figure 6. Interface Options

In the Interface Options page, Figure 6, it is possible select what interfaces FES system
provides.

1. Avalon slave A interface
a. Enabled in the reference design and connected to the NIOS in the QSYS
2. Avalon slave B interface
a. Enabled in the reference design and connected to the MDIO Slave in the
QSYS
3. External Speed interface
a. Not enabled in the reference design. Could be used to set speed/interface
mode for the FES ports.
4. Authentication Interface
a. Not enabled in the reference design. Must be exported and used, if an
external security chip is used for IP license validation
5. Transceiver reconfiguration interface
a. Not enabled in the reference design. Could be used for providing
reconfiguration interface from external controller. Usually used in designs with
multiple FES cores using transceiver interfaces.
6. Traffic LED interface
a. Enabled in the reference design. Provides signals for driving traffic LEDs (if
provided by the interface adapters)

In addition this page defines the following interface related generics:
- AVR_ADDR_MSB
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o Sets the Avalon address bus width. As a MSB definition it is actual width
minus one.
- LED_ACTIVE
o Selects logic level when Link LEDs should lit.
- GXB_CHANNEL_OFFSET

(@]

Not applicable since only one FES is instantiated inside one FPGA chip.
(]

In case there would be multiple FES inside one FPGA, the
GXB_CHANNEL_OFFSET needs to be individual for each.

3.3.3 Interface Configuration

In the Interface configurations page there are three sub pages.
FRTC configurations are common for Interface configuration pages.

System: xr7_softsoc  Path: fes_system_0

FLE\/lblLls FES System

fes_system

|~ Customization

DEFICE_FAMILY: ':"r'l:ll:lrlE W

Generics  Interface options  Interface configuration

Select time component: |FrTC

FRTC base address ©  |gw100000

Enable PPS interface

[ ] Enable FRTC to run at startup (at nominal speed)

[] Enable Event input interface

Figure 7. FRTC/FPTS Options

with these setting it is possible to enable the PPS signal output and start FRTC clock without

register configurations. The Event input requires a separately licensable block called Flexibilis
PPX Timestamper (FPTS).

3.3.3.1 Port Interface Type
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System: xr7_softsoc  Path: fes_system_0

ibiuis

FLe\/lblLls FES System

fes_system

= Customization

DEVICE_FAMILY: | -vdone IV GX

Generics  Interface options  Interface configuration

Select time component: | FRTC

St

FRTC base address | qyx100000
Enable PPS interface
[ ] Enable FRTC to run at startup (at nominal speed)

[] Enable Event input interface

Portinterface type Port base address  Adapter base address

Port Ointerface type @ | AFEC

v
Port linterface type : | SGMII/1000Base-X v2 w
Port 2interface type  : | SGMII/1000BaseX v2 “
Port Jinterface type @ | SGMII/1000Base-X v2 w
Port 4interface type @ oM w

Figure 8. Interface Configurations for Cyclone IV
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= Customization

DEVICE_FAMILY: [y clone v
Generics  Interface options  Interface configuration

Select time component: |FrTC

et

FRTC base address @ |y 100000
Enable PPS interface
[ ] Enable FRTC to run at startup (at nominal speed)

[ ] Enable Event input interface

Portinterface type  Port base address  Adapter base address

Port Ointerface type @ | aFEC

S

Port linterface type  : | SGMII/1000Base-Xf100BaseFX -
Port Zinterface type  : | 5GMII/1000Base-X/100BaseFX
Port 3interface type  : | 5GMII/1000Base-X/100BaseFX -
Port 4interface type | 5GMII/1000Base-¥/100BaseFY -

Figure 9. Interface Configurations for Cyclone V

The Port Interface type, Figure 8 and Figure 9, is used to select interface type for each port.
In these case:

- Port0is AFEC i.e. it used by the NIOS
- Port1, 2 and 3 are SGMII/1000BASE-X v2 [12] or Triple mode
- Port 4 is RGMII or Triple mode

Other possible interface types include:

- MIl PHY mode
o Provides interface, which is compatible with most PHY interfaces
GMII/MII Native (None)
o Provides FES GMII interface without modifications
o Mainly for internal use i.e. QuadBox
- 1000BASE-X
- 100BASE-FX
- EMAC (for Altera’s Ethernet Media Access Controller)
- RMII
- SGMII/1000base-X (using ALT_TSE)

EMAC is used in Cyclone V SoC designs.
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3.3.3.2 Port Address Configuration
System: xr7_softsoc  Path: fes_system_0

~LEe

ibiuis

|~ Customization

DE”ICE_FAMILT: C\rlclc"-le W

Generics Interface options  Interface configuration

Select time component: | FpTC v

FRTC base address @ | gwip0000
Enable PPS interface
[ ] Enable FRTC to run at startup (at nominal speed)

[ ] Enable Event input interface

Port 0 avalon base address (= MDIO base address)
Port 1 avalon base address (= MDIO base address)
Port 2 avalon base address (= MDIO base address)
Port 3 avalon base address (= MDIO base address)
Port 4 avalon base address (= MDIO base address)

Fortinterface type Portbase address  adapter base address

* |0x120000
* |0x040000
* |0x050000
* | 0080000

¢ |0x0 70000
Switch avalon base address (= MDIO base address) :

010000

Figure 10. Port Address Configurations

Port base address configuration, Figure 10, defines the Avalon address offset from FES
System base address for FRS Port and Switch configuration registers. Addresses are defined
as word addresses. Avalon address map is defined in Chapter 3.6.
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3.3.4 Adapter Address Configuration
System: xr7_softsoc  Path: fes_system_0
FLeXIbiLis|.
fes_system
|* Customization
DE”ICE_FAMILY: C'.rlch:"-le W
Generics  Interface options  Interface configuration
Select time component: | FpTC v
FRTC base address ©  |ow100000
Enable PPS interface
[ ] Enable FRTC to run at startup (at nominal speed)
[ ] Enable Event input interface
Portinterface type Port base address  Adapter base address
Port 0 adapter avalon base address (= MDIO base address) @ gwoa0oo0o
Port 1 adapter avalon base address (= MDIC base address) : |gy020200
Port 2 adapter avalon base address (= MDIO base address) @ |oxn20400
Port 3 adapter avalon base address (= MDIO base address) @ gwoz0500
Port 4 adapter avalon base address (= MDIO base address) @ gwoz0800

Figure 11. Adapter Address Configurations

Figure 11 presents adapter base address configuration, which defines the Avalon address
offset from the FES System base address for adapter registers. Addresses are defined as

word addresses. Avalon address map is defined in Chapter 3.6.

3.4 MDIO Slave Configuration

Also the MDIO slave QSYS component (Figure 3) provides certain configurations for the user.
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|"’ Generics
RST_ACTIVE: i

CFG_MDIO_ADDR: g

|~ Options
[ ] Enable cfg_mdio_addr signal interface

Enable mmd_mdio tri-state buffers

Figure 12. MDIO Slave Configurations

Figure 12 presents MDIO Slave configurations page with settings used in this case.
Configurable generics are:

- CFG_MDIO_ADDR
o Default value for MDIO address, if cfg_mdio_addr input is not used.
- Enable mmd_mdio tri-state buffers
o Enable tri-state buffers
- Enable cfg_mdio_addr signal interface
o Enabled the cfg_mdio_addr signals, which can be used to configure MDIO
address for the MDIO Slave

3.5 Interface Adapters

Interface adapters are used with FRS to provide other Ethernet interface types than the FRS
native MII/GMII. Figure 4 illustrates the Adapters used in this Reference Design. However, the
FES System provides also other interface adapters as mentioned in chapter 3.3.3.1.

Some of the adapters include registers for configuration and status. For more information
about the adapters refer to the SGMII/1000Base-X adapter specification [12] and Interface
Adapters specification[13].

3.6 Avalon Address Map

The Avalon Address Map is based on the settings in QSYS and its components. The Table 1
below defines the Address map for this Reference Design. Addresses are defined as word
addresses.

BUS and Base Address
AFEC TX/RX

Component

Data

Instruction

Buffer

JTAG, debug on NIOS

0x0404_0800

0x0404_0800

JTAG, Uart

0x0400_0010

Onchip Memory

0x0500_0000

0x0500_0000

0x0500_0000

12C_interface_0

0x0400_0100

12C_interface_1

0x0400_0140

12C_interface_2

0x0400_0180

12C_interface_3

0x0400_01c0

Flash

0x0000_0000

0x0000_0000

Sys ID

0x0400_0000

LCD (Clock Crossing)

0x0700_0000
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Component BUS and Base Address
Timer 0x0400_0080
PIO LED 0x0400_0040
PIO DIPSW 0x0400_0420
PIO PB 0x0400_0400

PIO REF. Design
version

0x0400_00c0

PIO CTRL 0x0400_0440
ETH MDIO tristate 0x0400_0300
FES System 0x0600_0000
Switch
Switch registers 0x0601_0000
TS 0x0601_1000
VLAN 0x0601_2000
FRS Port 0
GEN 0x0612_0000
HSR 0x0612_1000
PTP 0x0612_2000
CNT 0x0612_3000
IPO 0x0612_4000
FRS Port 1
GEN 0x0604_0000
HSR 0x0604_1000
PTP 0x0604_2000
CNT 0x0604_3000
PO 0x0604_4000
FRS Port 2
GEN 0x0605_0000
HSR 0x0605_1000
PTP 0x0605_2000
CNT 0x0605_3000
IPO 0x0605_4000
FRS Port 3
GEN 0x0606_0000
HSR 0x0606_1000
PTP 0x0606_2000
CNT 0x0606_3000
PO 0x0606_4000
FRS Port 4
GEN 0x0607_0000
HSR 0x0607_1000
PTP 0x0607_2000
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Component BUS and Base Address
CNT 0x0607_3000
IPO 0x0607_4000
Adapter PO

AFEC 0x060A_0000
Adapter P1

SGMII/1000BASE-X | 0x0602_0200
Adapter P2

SGMII/1000BASE-X | 0x0602_0400
Adapter P3

SGMII/1000BASE-X | 0x0602_0600
Adapter P4

RGMII 0x0602_0800
FRTC 0x0610_0000

Table 1. Avalon Address Map

3.7 Compilation

This chapter describes shortly the Reference Design compilation steps. For more detailed
information about Quartus, please refer to the documentation available in Altera’s website.

The Reference Design package includes ready-to-use program files, so compilation is not a
mandatory step.

3.7.1 Folder Structure

The Reference Design folder structure is illustrated in Figure 13. The fpga folder includes
bin_qgsys folder, which includes most of the quartus project files. In addition there is an ip
folder, which includes QSYS component files. The FPGA project expects that external and
encrypted_ip folders are in place and have the correct content. Therefore the user should
place separate FRS, FRTC and AFEC IP cores into the correct folders or change the file path
settings in Quartus project accordingly.

FRS Reference Desing

- Cyclone<Device>devkit_softsoc
> external
-2 AFEC (To be added)
-2 FRTC (To be added)
> fpga
- bin_gsys
> ip
- bin
- script
> sw
- encrypted_ip
FRS files

Figure 13. Folder Structure
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3.7.2 QSYS Generation

The Reference Design is fully described by xr7_softsoc.gsys file, because it is directly the top
level of the design. The QSYS system needs to be generated before the first synthesis/fitting
is done, since the QSYS result design files are not included in the package. Also, the QSYS
system needs a regeneration if something in the QSYS system is changed or the source
codes of the QSYS components are modified.

QSYS is opened from Quartus. First, open the cyclone<Device>devkit.qpf (Quartus Project

File) with quartus. Then on the toolbar open the QSYS e . Once QSYS opens, it will query
the gsys system file to be opened. This is the xr7_softsoc.qgsys file that is located in the
bin_gsys folder. Once correct system has opened the user can either make changes or then
directly generate a new gsys design. Generation is activated from the Generation page,
pressing the Generate button. There should not be any errors or warnings during the
generation. Once generation has finished, all necessary files have been generated and user
can return to the Quartus project.

3.7.3 Quartus Project

The quartus project is configured with the correct assignments (pinout, 10 Voltage, clock
constrains etc.) and file references. The user should also make sure that the links to the files
are correct, especially for the external IP cores.

To be able to compile the design, the user should make sure that the required licenses are
available for the Quartus tool. The license setup can be found in the Tools menu. This
Reference Design requires:

- FRS (Flexibilis)
AFEC (Flexibilis)

o OCP license provided
- FRTC (Flexibilis)

o OCP license provided

- NIOS (Altera)
- SGMII/1000Base-X (Flexibilis)
- RGMII (Flexibilis)
- MDIO Slave (Flexibilis)

All of these licenses are available for evaluation.

Once the QSYS system is generated and the licenses are set, the design can be compiled in

normal way. The design will generate warnings, and they should be looked thought. However,
they all should be generated by Altera blocks and should not affect the operations. In case of

suspicious warnings contact Flexibilis.
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4 SW Reference Design

SW Reference Design is implemented as a modular design. The modules are depicted in

Figure 14.

Control
app

Protocols

Libraries

NIOS
BSP

Figure 14. SW Reference Design

The modules depicted in Figure 14 are located in separate directories under sw directory in
reference design directory.

Directory Description

xr7_softsoc_control XR7 SoftSoC Control - control application. Source code is located in
Reference Design release in FESHAOOEQO-FBIT-
V<ver>\cyclone4GXdevkit_softsoc\sw\xr7_softsoc_control\src
directory.

Xr7ptp XR7 PTP — PTP protocol stack library [2], [3]. Source code is delivered
separately and requires a license from Flexibilis Oy.
flx_redundancy_supervision | HSR/PRP Supervision protocol [1], [4]. Source code is delivered
separately and requires a license from Flexibilis Oy.
frs_management_protocol FRS Management Protocol [5]. Source code is delivered separately
and requires a license from Flexibilis Oy.

time_daemon Interface libraries for XR7PTP

xr7_softsoc_nif Helper library, contains for example drivers for IP blocks and
controlling of SFP modules and external PHY. Source code is located
in Reference Design release in FESHAOOEQO-FBIT-
V<ver>\cyclone4GXdevkit_softsoc\sw\xr7_softsoc_nif directory.
flx_fes_lib Helper library, for accessing FRS configuration. Source code is
located in Reference Design release in FESHAOOEQO-FBIT-
V<ver>\cyclone4GXdevkit_softsoc\sw\flx_fes_lib directory.

Iwip IwlP - A Lightweight TCP/IP stack, licensed under BSD license (see
Chapter 7). Source code is located in Reference Design release in
FESHAOOEOO-FBIT-V<ver>\cyclone4GXdevkit_softsoc\sw\lwip
directory.

frs_bsp BSP for NIOS, generated by Altera NIOS Il EDS according to
delivered configuration. Configuration is available in FESHAOOEQO-
FBIT-V<ver>\<board>\sw\frs_bsp directory.

Table 2. SW Reference Design Modules

Source codes for protocol stacks (XR7 PTP, Redundancy supervision, FRS management
protocol) are delivered separately and they require a license with Flexibilis Oy. All protocol
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stacks are included in the Reference Design release in a binary format and the functionality
can be verified using the evaluation boards.

4.1 Modules

4.1.1 XR7 SoftSoC Control

XR7 SoftSoC Control is the main module of the system. It handles the initialization of all the
other modules and threads and performs control tasks during the execution. The source code
files are listed in Table 3.

File Description

src/xr7_softsoc_ctrl.c Main initialization and control functions. For example, initializes all
threads, scans ports, DIP-switches, updates configurations and
prints to LCD.

src/xr7_softsoc_ptp.h XR7 PTP thread handling: configuration and control.
src/xr7_softsoc_ptp.c
src/xr7_softsoc_supervision.h Flexibilis Redundancy Supervision module thread handling:
src/xr7_softsoc_supervision.c configuration and control.

Table 3. XR7 SoftSoC Control Module Files

4.1.2 XR7PTP

XR7PTP implements Precision Time Protocol [2]. XR7PTP is described in detail in XR7PTP
User Manual [3].

4.1.3 Flexibilis Redundancy Supervision

Flexibilis Redundancy Supervision implements HSR/PRP Supervision protocol [1]. Flexibilis
Redundancy Supervision is described in detail in Flexibilis Redundancy Supervision Design
Specification [4].

4.1.4 FRS Management Protocol

FRS Management Protocol implements a proprietary management protocol for managing
FRS Reference Design. FRS Management Protocol is described in detail in FRS
Management Protocol specification [5].

4.1.5 Time Daemon

Interface libraries for XR7PTP are included in time daemon directory. These packet and clock
libraries integrate XR7PTP to this NIOS reference design. More information about the role of
these libraries can be found from XR7PTP User Manual [3].

4.1.6 XR7 SoftSoC NIF

XR7 SoffSoC NIF module contains drivers and other helper functions. The source code files
are listed in Table 4.
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File

FLE)QMUS
Description

Inc/card_if.h

Definitions for Reference Design. For example GPIO mapping,
config options, etc.

inc/88e1000_ctrl.h
src/88e1000 ctrl.c

Marwell 88e1000 PHY driver

inc/afec.h
src/afec.c
inc/flx_afec.h
src/flx_afec.c

AFEC IP (Ethernet MAC) driver [6]

inc/ethernet_input_thread.h
src/ethernet_input_thread.c

Optional support for two level IRQ handling in Ethernet MAC.
Enabled in card_if.h with ENABLE_ETHERNET_INPUT_THREAD
define.

inc/flx_frs_if.h
src/fes ctrl.c

Device driver for FRS IP. [7]

src/nif ctrl.c

inc/frtc.h Device driver for FRTC IP. [8]

src/frtc.c

inc/i2c_ctrl.h I12C bit bang device driver.

srcli2c_ctrl.c

inc/nif_ctrl.h Network stack (Iwip) initialization and helper functions.

inc/adapter_ctrl.h
src/adapter_ctrl.c

Adapter management

inc/interface_ctrl.h
src/ interface _ctrl.c

Configuration and control for different interface types

inc/phy_ctrl.h
src/phy _ctrl.c

Configuration and control for PHYs

Table 4. XR7 SoftSoC NIF Module Files

4.1.7 flx_fes_lib

The library contains helper functions for managing FRS. The source code files are listed in

Table 5.
File Description
fix_fes.h Helper functions for configuring FRS IP [7]. Includes for example
flx_fes.c reading and writing of FRS registers and IPO settings.

Table 5. fIx_fes_lib Module Files

4.1.8 lwip

The library contains IwlIP - A Lightweight TCP/IP stack. It is an open source TCP/IP stack. More
information can be found in lwip documentation [9].

4.1.9 frs_bsp

Board Support Package (BSP) generated by Altera NIOS Il EDS tool.

4.2 Compilation

FRS Reference Design SW compilation is done in Altera NIOS Il EDS. All the module sources

listed in Table 2 need to be placed under FESHAOOEOO-FBIT-V<ver>\<board>\sw\ directory.
SW Reference Designs for different boards use the same module sources. Only frs_bsp,
which is generated by the Altera NIOS Il EDS tool is board dependent.

4.2.1 Import Projects

Every SW module is implemented as a separate project in NIOS Il EDS. They have to be
imported separately and after all the projects have been imported, the application can be

compiled.

Importing steps are the following:

Specification

28 (34)

Version 1.7



FRS Reference Design FLE&DILIS

1. Select File->Import

Select
> 5]
Import a file from the local file systemn inte the workspace,

Select an import source:

| type filter text |

[+ [= General

b= GG+

[ = CVS

[ = Git

[ = Install

4 [= Mios Il Software Build Tools Project
|@ Irmport Customn Makefile for Nios I Software Build Tools Project |
& Import Mios I Software Build Tools Project

[» == Remote Systems

[» [ Run/Debug

[ = Tasks

[ = Team

2. From menu, select “Nios Il Software Build Tools Project” and under that selection,
select the correct import mode (discussed later).
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= Importing a custom Software Build Tools pm E@g
- i — —

Import the custom project folder

Folder not found

Project location:  cycloned GXdevkit_softsocswhard_ptp | Browse...

Project name: xri_ptp

[7] Clean project when importing

Managed project

Toolchain: ’MinGW MiosTGCC4 -

@ Ned> | [ Finish | [ Cancel

3. Click Browse and select SW module directory, for example xr7_ptp. Set “Project
name:” the module name, in this example xr7_ptp, and click Finish.
4. Perform the steps 1-3 for every SW module.

In step 2, correct import type must be selected. All the protocol libraries and the Iwip-library
must be imported as “Import Custom Makefile for Nios Il Software Build Tools Project”. All the
other modules shall be imported as “Import Nios Il Software Build Tools Project”.

4.2.2 Build Application

The first step in building the application is to include all other modules as referenced projects
to xr7_softsoc_control. This can be done by first selecting xr7_softsoc_control project from
Project Explorer in the left and then selecting File->Properties.
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' e i
= Properties for xr7_softsoc_control Elﬁlg
type filter text Project References (=l g v v

Resource . ) !
Projects may refer to other projects in the workspace,

Builders Use this page to specify what other projects are referenced by the project.

C/C++ Build
C/C++ General Project references for 'wrf_softsoc_control':
Mics I Application Properti ;
Project References
J, - bc'flx_redundancy_supenrision
Run/Debug Settings -
Task Repository bc'frs_bsp
WikiText = frs_management_protocol
= Iwip I
2T _ptp
=5 xr7_softsoc_nif
4| 1 |
@j [ 0K J [ Cancel

Then check all the SW modules referenced in the properties window.

The next step is to generate BSP. This can be done by right clicking the frs_bsp project and
selecting Nios Il -> Generate BSP.

After this, all that is needed is to build xr7_softsoc_control project by selecting the project and
then selecting Project -> Build All. Now new xr7_softsoc_control.elf is generated.
4.2.3 Create Flash Files

New flash files can be generated with Nios Il Command Shell in FESHAOOEOO-FBIT-
V<ver>\<board>\script directory.

1. Open Nios Il Command shell from Windows Start menu
2. Goto FESHAOOEQO-FBIT-V<ver>\<board>\script directory
3. Execute ./create_flash_bins.sh

Select correct options for the script according to the help. The SW option will generate only
SW update flash file and the other options will generate also FPGA configuration flash file.
4.2.4 Program Flash

New flash files can be programmed to Reference Design board with Nios Il Command Shell in
FESHAOOEOO-FBIT-V<ver>\<board>\script directory.

1. Open Nios Il Command shell from Windows Start menu
2. Go to FESHAOOEOQO-FBIT-V<ver>\<board>\script directory
3. Execute ./flash_dev_board.sh

Select the correct options for the script according to the help. The SW option will program
only the SW and the other options will program also the FPGA configuration to the flash. After
programming the board, the board must be reset.
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5 Abbreviations

Term Description

AFEC Advanced Flexibilis Ethernet Controller
BSP Board Support Package

FES Flexibilis Ethernet Switch

FPGA Field Programmable Gate Array

FRS Flexibilis Redundant Switch, Variation of FES
FRTC Flexibilis Real Time Clock

HSR High-availability Seamless Redundancy
PLL Phase Locked Loop

PPS Pulse Per Second

PTP Precision Time Protocol

SFP Small Form-factor Pluggable transceiver
SoC System-on-Chip

Specification 32 (34) Version 1.7



FRS Reference Design FLE&DILIS

6 References

[1] Standard IEC 62439-3:2011
[2] IEEE standard 1588-2008
[3] XR7PTP User Manual, xr7ptp_user_manual.pdf

[4] Flexibilis Redundancy Supervision design specification,
flx_redundancy_supervision_design.pdf

[5] FRS Management Protocol, FRS_management_protocol.pdf

[6] Advanced Flexibilis Ethernet Controller (AFEC) User Manual,
AFEC_user_manual.pdf

[7] Flexibilis Ethernet Switch (FES) Manual, FES_Manual.pdf
[8] FRTC User Manual, FRTC_user_manual.pdf

[9] IwlIP - A Lightweight TCP/IP stack, open source,
http://savannah.nongnu.org/projects/lwip/

[10] Triple-Speed Ethernet MegaCore Function User Guide, version 13.1, December
2013, http://www.altera.com/literature/ug/ug_ethernet.pdf

[11] IP License Authentication, Security Chip, Manual, version 1.2.
http://www.flexibilis.com/downloads/Security Chip.pdf

[12] SGMII/1000Base-X adapter Specification, FLXD816,version 1.0
[13] Interface Adapters specification, FLXD817, Version 1.0

Specification 33 (34) Version 1.7


http://savannah.nongnu.org/projects/lwip/
http://www.altera.com/literature/ug/ug_ethernet.pdf
http://www.flexibilis.com/downloads/Security_Chip.pdf

FRS Reference Design ~Le)1ibius

7 BSD License

BSD License of the IwIP stack:

Copyright (c) 2001, 2002 Swedish Institute of Computer Science.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR " "AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

This file is part of the 1lwIP TCP/IP stack.

Author: Adam Dunkels <adam@sics.se>
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